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Summary

In this document you will learn how to install, configure and use the Smart Building
Manager (SBM) for room automation on Windows systems.

For further information about Smart Office facilities, standards, parameters and options
please refer to the chapters “"Apps” and “SmartOffice” in [1] (see “Bibliography”).

For detailed information on using Smart Building Manager please refer to [2] (see
“Bibliography”).

Information available from the MICROSENS Website

Registered users can find the latest firmware versions as well as further information on our
web site:

e Registration: www.microsens.de > Login > Follow the link ‘Not registered?’ > Fill in the
opening email form and submit it to MICROSENS.

o You will receive an email from MICROSENS with a user name and a password

e Login: www.microsens.de > Login > Enter user name and password > Click the ‘Login’
button

o Firmware images: Navigate to the device and select the tab 'Services’
o For further information select one of the other tabs

Note:
Make sure the browser allows the execution of scripts.

Note:

After updating the firmware either by Web Manager or CLI be sure to clear the cache of the
browser you are using to open the Web Manager of the respective device. This will force the
browser to reload the device’s updated web GUI data instead of using the outdated data
from its cache.

Bibliography
[1] Product Manual Firmware Generation 6

This manual is included in each software archive containing Firmware G6. It can also be
downloaded from the link “*Documentation” in the firmwares’ Web Manager navigation bar.

[2] User Manual Smart Building Manager

This user manual is included in SBM Server and SBM Client via help menu. It describes in
detail on how to use Smart Building Manager properly.

Before you begin

In case of questions please contact your sales representative to make sure that you
received the latest version of Smart Building Manager Software including a valid licensing
key file.

Also please check if the computer system where SBM will be installed matches the system
requirements.
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0 Summary Steps

This document will guide you through the following steps to properly install the MICROSENS
Smart Building Manager:

1) Check prerequisites

2) Install the software

3) Start server and apply license file

4) Configure SBM Server

5) Start SBM Server

6) Start SBM Client

7) Login and change the Super Admin password

8) Create additional Admin users

9) Create the building topology for room automation

10) Discover the devices

11) Adjust communication parameter for polling rate

12) Assign devices to the corresponding node of the building topology tree
13) Define the data points per device where you want to see history data charts

14) Using the SBM WEB UI to verify your custom settings

1 Check Prerequisites

1.1 System Requirements
SBM is designed to run on dedicated servers with the following minimum requirements:
e Microsoft Windows® 8 operating system or newer,

e RAM: 4GB (server component),
2GB (client component),

Free installation disk space: 2GB (server component),
1GB (client component),

Disk space for SBM data: min. 10 GB per 1000 managed objects,
Display resolution of at least 1280*1024.

For network access a network interface with TCP/IP stack must be installed and configured.
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1.2 Using the Browser based User Interface

A user interface is provided through a Web browser that runs on a user’s local computer or
workstation with all operating systems (Microsoft Windows®) and connects to a server as
necessary. The minimum display resolution is 1280*1024.

Supported web browsers are:
e Mozilla Firefox 3 (72.0.2) and newer
e Chrome 80.0.3987 and newer

Note:
Support for JavaScript has to be enabled at the web browser. There is no need to install any
additional plug-ins.

2 Install the SBM Software

This section describes the installation process of MICROSENS Smart Building Manager.

Note:
You need administrative rights as a prerequisite to install the server component of SBM.

Note:
To use the server component a valid licence key file is required.

In order to install SBM, start the provided installer utility and follow the steps described
below.

Note:
The language for the installation process depends on the language setting of the operation
system. It has no influence on the language setting of the management application.

Note:
The following steps describe the installation process on a Microsoft Windows® based system.

2.1 Run the Install Executable
The naming convention of the installer is as follows:

e MICROSENS SBM Installer v2.x.y wint4.exe

On the welcome screen click the button Next in order to enter the licence agreement
dialogue.

After reading the licence agreement click the button I Agree to go to the product selection
dialogue.

Note:
It is necessary to scroll down the licence agreement to the end to enable the button
I Agree.
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2.2 Choose Components
With SBM there are two components available for selection:
e Server: Installs the server component of SBM and its respective supplements.

e Client: Installs the client component of SBM and its respective supplements.

~3 MICROSENS 5BM Setup — x

Choosze Components
Choose which Features of MICROSENS SBM you want ko install, 'ﬁ

Check the components wou wank to install and uncheck the components wou don't want to
inskall, Click Mext bo continue.

Select companents ko inskall: =" Diesicilgidian

SEM Server

Jawa Runkime
- [#] Start Menu Sh
[ ] Deskrap Icon !
-4 Client

SEM Client

Space required: 534.2ME = :_I..ava Runtlm_el W

< >

< Back Cancel

Figure 1: Choose SBM Components

Check or uncheck the components and their respective supplements for installation and hit
the button Next.

Note:
The installation of the client component is mandatory to access the server. For separate
installations of clients on respective computers uncheck the option “Server”.

-7 -
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2.3 Choose Users

On the user selection screen, select the group of users who are to use this software:

=g MICROSENS 5BM Setup — >

Chooze Uszers
Choose For which users wau want ko install MICROSENS SEM. ’ﬁ

Select whether vou want ko install MICROSENS SBM For yourself only or for all users of this
computer, Click Mext ko continue.

() Install for anyone using this computer

(®) Install just For me

< Back Cancel

Figure 2: Choose Users

« Install for anyone using this computer: Every registered user on this computer is
able to use the management application after installation. This should be enabled in
exceptional cases if it is ensured that only the responsible network administrator have
access to this computer.

o Install just for me: Only the user logged in can use the management application,
whereas other users can’t (default option for security reasons).

Hit the button Next to go to the components selection screen.
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2.4 Choose Install Location

On the respective installation location screens determine the destination folders for SBM
Server and SBM Client (if SBM Client installation was previously selected).

~3 MICROSENS 5BM Setup — x

Chooze Install Location
Choose the Falder in which to install MICROSENS SBM Server, ,..E

Setup will install MICROSENS SBM Server in the Following folder, Toinstall in a different Folder,
click. Browse and select another Folder, Click Mext ta conkinue,

Destination Folder

_:1Program FilesiMICROSENSSEM) Server Browse, .,

Space required; 534, ZME
Space available: 4, 1GE

< Back Cancel

Figure 3: Choose Install Folder

Hit the button Next (for SBM Client installation folder, if applicable) and the button Install
to start the installation process on the system.

When the installation process is finished successfully click the button Finish.
MICROSENS Smart Building Manager is ready to be started.
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3 Start the Server and Apply a Licence Key File

3.1 Insert USB Licence Dongle

The full version of MICROSENS Smart Building Manager is shipped with a licence USB
dongle (hardware USB key). Please connect the USB dongle to a free USB port of the
computer on which the server component is installed.

3.2 Start SBM Server

In order to start the server component use one of the links provided in the Microsoft
Windows® Start menu:

e Start > MICROSENS > MICROSENS SBM Server

3.3 Select Licence Key File for SBM Server

Note:
Running SBM server component does not require any login but a valid licence key file. The
licence file is necessary to use the server.

If no licence has been selected (especially after installation of the software) the following
dialogue prompts to select the licence key file.

,";'-; SBM - licence pod

= SIART
BUILDIMG

= MANAGER

Select licence file

Cloze

Figure 4: SBM Licence Key Selection

Note:

The evaluation or trial licence of SBM does not include a USB dongle. When starting the
server with an evaluation or trial licence please confirm the respective error message
reporting a missing hardware USB key.

If you do not have a valid licence file please contact MICROSENS.
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4

4

Configure SBM Server

MICROSENS

.1 Configure the Server Communication Settings

Server settings  Client authentication settings  Syslog/Logs/Events Database backup/restore Database replication Email notification  SNMP Agent  InfluxDB Client

I Server data dir path: ‘ C\Users\User\SBM Server Select I
Require password on SBM Server Manager startup: O Set Password
Start server on SBM Server Manager startup: O
Start SBM Server Manager minimized: O
IPv4 Interface for device communication: 127.0.0.1 ~
IPv6 Interface for device communication: disabled
Max. concurrent data poll threads: IE =
Use built-in SNMP Trap Listener (on port udp/162): ]

I Interface for client-server communication: 127.0.0.1 ~ I
Port for client-server commands:

FTPS (FTP ower 55L) Server port:

P s

FTP Password: Set Password
Database Server port:

Enable Web Server: O

Enable secured http connections (https):

HTTPS enabled

Port for incoming http(s) connections:

Figure 5: SBM Server - Tabbed Server Configuration Panel - Server Settings

The most important settings for first configuration are marked in Figure 5:

Configure Server data directory path: Configure the directory where SBM Server
will save all necessary configuration files and database data. The default folder is:
$USER_HOME\SBM Server. In the selected destination folder a new folder ‘SBM Server’ will be
created.

IPv4 Interface for device communication: The IPv4 address of the network
interface that will be used for communication with the managed devices. In a more
complex network infrastructure where the server hardware has more than one network
adapter, it is possible to use one interface (accessible exclusively from secured local
network) for device communication and another one (accessible from external network)
for client access. Thanks to this function the clients do not have direct access to
managed devices. The devices can be accessed exclusively through SBM Server.

IPv6 Interface for device communication: The IPv6 address of the network
interface that will be used for communication with the managed devices.

Interface for client-server communication: The IPv4 address of the network
interface that will be used for client access (SBM Client). If the HTTP server is enabled
for Web Client access, the interface is also used by the built-in HTTP server.

Enable HTTP Web Server: Enables or disables the built-in HTTP server that is used
for Web Client access.
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¢ Enable secured http connections (https): SBM Server offers secured HTTP

connections for web access. The https connections are encrypted so the communication

between clients and server is safe. It is recommended to enable HTTPS for all
installations.

e Port for incoming http(s) connections: The port that will be used for the HTTP(S)

server. On default SBM Server uses the ‘8443’ for HTTPS connections.

5 Start SBM Server Process

Click on the button Start Server to start the SBM Server process

| Start server Stop server Save And Exit

Figure 6: SBM Server - Start Server Process

If server was started successfully then you should see a message in the Status field as
follows:

Status

03.02.2020 - 110752 Sepcer started..,

03.02.2020 - 110752 Switch IP Request listener started...
03022020 - 110752 Web server started.., Server available at: hitp
03.02.2020 - 11:07:50  Starting web server...

Figure 7: SBM Server - Status Field

6 Start the SBM Client

In order to start SBM Client use one of the links which are provided in the Microsoft
Windows® Start menu:

e Start > MICROSENS > MICROSENS SBM Client

7 Login via SBM Client

At the very first time please login as “Super Administrator” with the following credentials:
e Login: Super Admin
e Password: Super Admin

-12 -
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8 Change Password for User “Super Admin”

Note:
For safety reasons it is strongly recommended to change the password for all users,
especially the user “Super Admin”!

8.1 Switch to User Management Perspective

« MICROSEMS Smart Building Manager [user: Super Admin@127.0.0.1 -> Super Admin]

File Deviceslist User Management Settings Discovery Tools Edit Window Help

® H | o | @:‘ (E:)| L -] '| |§| Q ﬁ Switch Perspective » Metwork Administration |
Device List |= Summary Device Status Show View » Building Administration

= 8 ToolBar Position ? ilding Web Dachboard 1
Search... Q IP address  Device name ToolBar lcon Size > User Administration

>
Device list locked Language |

Figure 8: SBM Client - Window - Switch Perspective - User Administration

Change to the menu entry Window > Switch Perspective and click on the entry
User Administration.

8.2 Unlock User List

Click on the key lock icon right below the main menu bar on the upper left:

=« MICROSENS Smart Building b

File Lk
s

A

File User Management Setting

38 Uself

Search.) 222 User manager J7 Accesstor

|| Search...

Figure 9: SBM Client - User Administration - Unlock User List

Now the lock icon changes to an “open lock” symbol.
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8.3 Open User Properties Dialogue

On the tab User manager select the user with the name “Super Admin” and click the edit
icon.

MICROSENS
828 User manager /7 Access to network devices| /§ Accessto building /7 Accessto Web Ul = 0
Search... Q
Llaes Lact o E-sazil Locscclmesl bl gt Laspasnuacc
Super Admin Super Admin Super Admin Super Admin Super Admin 2020-03-05 13:46:38.524

THrT mfllfl mfllll mfll” mfﬂLUf
manager manager manager manager Manager
sysadmin sysadmin sysadmin sysadmin Systern Administrator
user user user user User

<

E4) )

Figure 10: SBM Client - User Administration - Select User

The user properties dialogue opens up.

I 228 User manager J‘i, Access to network devices .-"'i, Access to building J‘i, Accessto Web Ul

|| Search...
i| Login MName Last name E-mail
|| Super Admin Super Admin Super Admin Super Admin
|| admin o i admin
manager = Edit my account X manager
sysadmin User name Super Admin sysadmin
1| user user
User last name Super Admin
E-mail Super Admin
Login Super Admin
Password change request [ |
Access level Super Admin
I Apply Close

Figure 11: SBM Client - User Administration - Edit User
Set the new password, retype it and click on the button Apply.

Finally click on the “open lock” icon on the upper left to submit the changes to SBM Server.
The lock icon changes to a “closed lock” symbol.
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9 Create additional Admin Users
It is recommended to add additional users with Smart Building Administrator access rights.
Therefore you need to unlock the users list again as you did in the previous step.

Click on the key lock icon right below the main menu bar on the upper left:

wz MICROSENS Srart Building P
File Uj

P

File User Management Setting

88 Uself

Search.) 222 User manager f‘i Accesstor

|| Search...

Figure 12: SBM Client - User Administration - Unlock User List

The lock icon again changes to an “open lock” symbol. Hit the button + to add a user. The
user properties dialogue opens, where you can enter the new users data and credentials.

=]
File User Management Settings Window Help
o MICROSENS
i2% User manager /7 Access to network devices| /§ Accessto building /7 Accessto Web Ul = 0
Search... = Add new user e 9
Login Mame e aemra Access level Last login time Last password ¢
U
sysadmin sysadmi}) Systemn Administrator
manager manageg | E-mail asmith@mycompany.c Manager
admin admin Administrator
SuperAdmin  Super Adh Login Super Admin 2020-03-05 13:46:38.524
< Password ssssssse >
| Password change request [ ] -
Access level Smart Office Admin ~
Systern Administrator
Add Administrator \‘

Manager

User

[ Smart Office Admin

Smart Office User

Smart Office Sysadmin

Super Admin

Smart Office Web User

Figure 13: SBM Client - User Administration - Add New User
e Enter name, last name and e-mail address.
e Enter credentials (login name and password).
e From the drop down list select the entry ,Smart Office Admin™ as access level.
Hit the button Add to create the new user.

Finally click on the “open lock” icon on the upper left to submit the changes to SBM Server.
The lock icon changes to a “closed lock” symbol.
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10 Create Building Topology

10.1 Switch to Perspective "Building Administration”

Change to the menu entry Window > Switch Perspective and click on the entry
Building Administration.

« MICROSEMS Smart Building Manager [user: Super Admin@127.0.0.1 -> Super Admin]

File User Management Settings Window Help

G Switch Perspective ¥ Metwork Administration
255 User manager | /{ Access to netv ToolBar Position » Building Administration
ToolBar lcon Size > Building Web Dashboard
Search...
| Language * User Administration
I mmiem Bl

Figure 14: SBM Client - Window - Switch Perspective - Buidling Administration

10.2 Create the Building Topology for Room Automation

Click on the key lock icon right below the main menu bar on the upper left:

« MICROSEMS Smart Building b

File De
s |

i

File Devices List User Manage

ErBuld 2 | & | @ @ | o

search..| [l Building Structure| | == T

Search...

Figure 15: SBM Client - Building Administration - Unlock Smart Office Configuration

With a fresh SBM Client installation the building structure is empty. The following steps will
guide you to create a building structure with the following hierarchical structure:

e Location
o Building
- Room Automation
e Floor
o Room
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Hit the icon + to add a location.

In the opening dialogue enter the name of
the new location.

Select the created location and hit the icon
+ to add a building.

In the opening dialogue enter the name of
the new building.

After the building was created expand the
building node and select the node with the
name “Room automation”.

Hit the icon + to add a floor.

In the opening dialogue enter the name of
the new floor.

After the new floor was created the building
structure should look like this.

Select the floor and hit the icon + to add
one or more rooms.

In the opening dialogue enter the name of
the new room.

The resulting building topology tree now
should look like this.

i £ &

£ A

MICROSENS

IEI If!i:-i:l | ﬁﬂ
ﬁm Ouilding Structure + ~
gy Addlocation

= = B8 ||gh

search...

N MC e mm

© @| ey

il Building Structure| == « ~ = 0O ||#
[ Add building

Search..,

> gy DE-Hamm

[l Building creator
5 Mylocation

4 & Mylocation
a [ tyBuilding
Foom automation
Technics

4 ¢y Mylocation
4 [l MyBuilding
4 Room automation
[T My First Floor

Technics

4 & Mylocation
a [ MyEBuilding
4 Foorm autarmation
[T My First Floor
Technics

4 ¢y Mylocation
4 [ MyBuilding
4 Foom autormation
4[] My First Floor
My First Roorm
My Second Roorn
Technics

Figure 16:Steps to Create Building Topology

Finally click on the “open lock” icon on the upper left to submit the changes to SBM Server.
The lock icon changes to a “closed lock” symbol.
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11 Discover Devices for Room Automation

11.1 Switch to Perspective "Network Administration”

Change to the menu entry Window > Switch Perspective and click on the entry
Network Administration.

v MICROSENS Smart Building Manager [user: Super Admin@127.0.0.1 -» Super Admin] - O

File DevicesList User Management Settings Tools Window Help

0 £ A | © @ | Fe Switch Perspective >| Metwork Administration
£y Building Structure & - ~ = B8 |[ghe Show View > Building Administration
Search... Q ToolBar Position ¥ Building Web Dashboard
v ¢4 Mylocation Seve ToolBar lcon Size * User Administration

v [ MyBuilding Language » [

Figure 17: SBM Client - Window - Switch Perspective - Network Administration

Click on the key lock icon right below the main menu bar on the upper left:

wz MICROSENS Smart Building

File Deviceslist User Manage

Device List
BviceH File DewvicesList User Manage
! = l_-_'|| - |@| I:@:Il L
| || Device List
= 8

Figure 18: SBM Client - Network Administration - Unlock Configuration
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11.2 Start Auto Discovery

Change to the menu entry Window > Discovery and click on the entry Device auto
discovery.

= MICROSENS Smart Building Manager [user: Super Admin@127.0.0.1 -> Super Admin] - O X

File Devices List User Management Settings | Discovery Teols Edit Window Help

: [ F|| D@ B DM 'l = | # Device auto discovery MICROSENS

| Device List = Summ... | ® Device SNMP-based aute discovery (SNMP v1/v2c) . | @ Active..| T O
= O &% MSP 1000 platform IP discovery

Search... e} IP addr Device IP-Range scan Last poll  Last response

Device list editable [00:11:15]
) Devices (0/0)

== Device auto discovery *
Executing command, please wait!

Columns select | Refresh table | Export table | Export specified data

Figure 19: SBM Client - Network Administration - Discovery - Device Auto Discovery
SMB Client starts to search for devices in the corporate network.

Note:
Discovery takes some time. As long as the discovery is running you will see the green
progress bar.

After the discovery scan is finished you will see a separate dialogue which contains the list
of the detected devices.

~a Device auta discavery EEEE]
Avticle Mo, Serialno, MAC address Enable DHCP P address Subnet mask Gateway Device name Adminpassword  Send  Status Add tolist
MIS860301M 472 00866952 | [ 00-60-87-09-E3-28 10142495 255.255.255.0 1014241 csLes
MS60301M 42 00813267 | [00-60-A7-09-66-6C 01412.20 5040 101412210 MICROSENS Centra ]
MIS660301M -2 00865954 | | 00-60-A7-09-E7-20 10142493 255.255.235.0 1014241 s L
WIS652110PM 2| [ 009312L¢ | [ 00-60-87-04-48-FF 10142490 255.255.255.0 295255255255 MICROSENS GSInd s ]
MSE52118PH 00462573 | [ 00-60-7-06-47-18 101004581 255.255.255.0 1010085254 Engine B
IIS65211P M 00461295 | [ 00-60-A7-06-43-05 10.100.85.60 255.255.255.0 10.100.85.254 Engine &
MEG5Z110PM V2 00848678 |  00-60-A7-09-48-8D 101812124 255.255.255.0 1014121 MICROSENS G Ind e i} I
MS660301M-472 00813242 | [ 00-60-A7-09-65-84 10141290 255.255.255.0 255255255255 MICROSENS Centra
MS52119Ph V2| (00764352 | [ 00-60-A7-08-8-CC 1014.12.92 255.255.25.0 014121 MICROSENS G6Ind
WIS652119PM-v2 | [ 00648585 | [ 00-60-A7-09-46-CB w4122 255.255.255.0 014121 MICROSENS G§ Ind
MIS660301M 42 00843427 | [ 00-50-A7-09-01-A¢ 10142402 255.255.255.0 1014241 csic
MS6521PH 00482548 | [00-60-A7-06-58-6A 101009563 255,255,255 10.100.85.254 Engine D
Discovered devices: 24, new devices: 5 << || »> [Pagelofl]

Filter

[ new devices  Full-text search: [[]Case sensitive © starts with () contains  [VIPvd [Z]1Pv6 Apply filter

Configuration

Enable DHCP Start 1P Subnet mask Gateway Adrmin password

disabled - Fillall
Configuration file: not selected... Select configuration file | [Inject data | | [ Generate configuration template |

0 Search Il = ]

Figure 20: SBM Client - Network Administration - Device Auto Discovery - Results
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Review the list of detected devices. Check all devices in the column Add to list that should
be part of your device list. Afterwards hit the button Add to list.

Hit the button Close to close the dialogue. All checked devices are now part of the device
list. You will find the discovered devices in the building structure under the node “Scan
results” > “Device auto-discovery”.

Finally click on the “open lock” icon on the upper left to submit the changes to SBM Server.
The lock icon changes to a “closed lock” symbol.

12 Adjust Communication Parameters for Polling Rate

Click on the key lock icon right below the main menu bar on the upper left:

« MICROSENS Smart Building b

File DevicesList User Manage

o nla]rs

Device List

File DevicesList User Manage
a1 IFJE @ ©| +
i Device List

= B8

Figure 21: SBM Client - Network Administration - Unlock Configuration

Select the building structure node “Devices”, open the context menu with a left mouse click
and select the menu item Add new Subgroup.

HEAFCRL

Dewvice list editable [00:00;28]

4 |l ;) Devices (1 #  Poll group data

4 ] Net-10
'&' 10 Device configuration loadfsawe
%13 Master Configuration
'Ef 10 Update firrmuare
& 10 Applications installer
iyl
-_&é :E Reset switches
310 ,

4 5 Net1D 4 Add new device
-.a 10/ tg Add new subgroup
L2 1o -

Figure 22: SBM Client - Network Administration - Devices Context Menu - New Subgroup

Define the name of the new device group. This device group is used as a container which
contains all devices in which you are interested on.

Afterwards use drag & drop to assign a device from the “"Device auto-discovery” group to
your new group.
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Select the node name of your group and do a right mouse click to open the context menu.

5:. My Group ("

L3 19216
Scan results

21014248
fi Device aut
3 10100
3 10.100
3 10100
[ 19215
3 10100
Lo 10142
[ 19218
[ 19218
L3 10.100
3 10.100
(3 10.100
3 10.100

L

Foll group data

Device configuration load/sawve
Master Configuration
Update firrrware

Applications installer
Reset switches

Add new dewice

Add new subgroup

Copy
Cut

Paste
Delete group

Edit group narme

Communication pararmeters

=)

[CTRL +c]
[CTRL +x]
[CTRL +]

[CEL]

[F]

Figure 23: SBM Client - Network Administration - Devices Context Menu - Communication

Parameters

Click on the menu item Communication parameters to open the configuration dialogue.
At the bottom of the dialogue you see the parameter setting for the polling.

Please set the parameters as shown in Figure 24 and hit the button Apply.

Fasawiarg

Auto refresh:

Cormmunication pararneters

Connection TimeQut [sec]:

Connection retries:

Total dewvice timeout: 2 [sec]

Data Auto Poll tirme intersal:

[¥] enable

Apply

]l[ Close

Figure 24: SBM Client - Network Administration - Devices - Communication Parameters

Finally click on the “open lock” icon on the upper left to submit the changes to SBM Server.
The lock icon changes to a “closed lock” symbol.
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13 Assign Devices to the Corresponding Node of
Building Topology Tree

13.1 Switch to Perspective "Building Administration”

Change to the menu entry Window > Switch Perspective and click on the entry
Building Administration.

« MICROSENS Smart Building Manager [user: Super Admin@127.0.0.1 -> Super Admin] — C

File DevicesLlist User Management Settings Discovery Toels Edit Window Help
B R | o | @ ':l':‘:'| +* ] "| E Q Switch Perspective > MNetwork Administration
Device List = Surmmary Device Stat... | #2 Show View >I Building Adrministration

= B8 ToolBar Position » Building Web Dashboard
Search... IP address Device name | ToolBar lcon Size ¥ User Administration

L »

Device list locked anguage [

Figure 25: SBM Client - Window - Switch Perspective - Building Administration

13.2 Assign Devices to building nodes

Note:
This step is important because you need to add a context to each device. This means that
you need to define which device is responsible for which building part.

Click on the key lock icon right below the main menu bar on the upper left:

« MICROSEMNS Smart Building M

i

File De
Wa) |

3 File Devices List  User Manage
Babuid 2 |e o | @ @ | «f
Search... ﬁ:ﬂ Building Structure + -

Search...

Figure 26: SBM Client - Building Administration - Unlock Configuration

All devices found in the previous step are listed in the section “"Devices” below the section
“Building Structure”.
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From this list select a device and assign this device to a building node using “drag and drop”
with a left mouse click.

- g repeanny
a Room automation
4 [T by First Floor
# by First Raorn
by Second Roarn

Technics
192168, UM, 03.02.202.
:&;Devices R
Search...
Mame Location Domain  IP Address  State  Last update it
& R 192.168... UM.. 03.02.202.
R 10,1008, UM.. 03.02.202.
ML, 192.168...  UM.. 03.02.202.
ML 192.168...  UM.. 03.02.202.
ML 192.168...  UM.. 03.02.202. 3

Figure 27: SBM Client - Device List

If you drop the device (release the left mouse button) on a building node the device will be
assigned. The assigned device is shown as a sub-node of the building node:

4 ¢y Mylocation
4 [y MyBuilding
4 Roorm autarmation
4 [ My First Floor
a4 o My First Room
& BU-3BSEG
# My Second Roorn
Technics

Figure 28: SBM Client - Device Addigned to Node

Continue until all needed devices are assigned to their specific building node.
Note:
A node can contain multiple devices but a device can only be assigned to one node.

Finally click on the “open lock” icon on the upper left to submit the changes to SBM Server.
The lock icon changes to a “closed lock” symbol.
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14 Define Data Points per Device for History Data
Charts

14.1 Unlock the key lock for the building structure

Click on the key lock icon right below the main menu bar on the upper left:

w MICROSENS Smart Building

File De
Wa) |

]

3 File DevicesList User Manage
frbuid 2 |l & | @ @ | o
Search... ﬁq} Building Structure + -

Search...
Figure 29: SBM Client - Building Administration - Unlock Configuration

14.2 Select a Device for Monitoring History Data

Select the device of a building tree node where you want to see history data charts

i Building Structure - = = 0

Search...

4 ¢y DE-Harmm
4 [ MICROSEMS
a Foom automation
4 [ Groundfloor
a4 B BuOffice
| & Smart Building SOlutions |
Technics

Figure 30: SBM Client - Select Device for Monitoring History Data
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14.3 Select Data Points for History Saving

Go to the Tab “Data points” at the right hand side to see a list of all data points of a single
device. You should see a list like in Figure 31.

B Building Stucture = B |[@® Data Points| 8 Devices | g Sensors| g Actors
- % <[ snge [Group
Search. [a]/|{loim
4 @ DE-Hamm
B Mrosens B CustomID Customname Path Attribute Value  Valuernin  Value max  Unit  State EventSeverity  Read/Write Last update Log On Valll Save history
2[5 Roorn sutormation 380 Jsmartoffice/actor_group_status/Dimlevel Zone_1_Cold LED_PANEL W0 00 0.0 ok DISSELED Read/write 22.01.2020 05:08:36
4 [ Groundioor ) Jsmartaffice/actar_graup_status Dirlevel Zane 3 _Cald LED_PANEL Wm0 0 0.0 oK DISABLED Read/Write 22.01.2020 05:08:36
4 B BuOffice e Jsmartoffice/actor_group_status/Bimlevel Zone_§ Warm LED_PANEL 2w 0.0 ok DISABLED Read/rite 22.01.2020 05:08:36
© SmartBuilding SOI | 38 Jsmartoffice/actor group_status/Dimlevel Zone_2_Cold LED_PANEL W0 00 0.0 oK DISAELED Read/write 12.01.2020 05:08:36
Technics 389 fsmartaffice/actor_group_status /Dirmlevel Zone_10_Warm LED_PANEL 2w 0.0 oK DISABLED Read/Write 22.012020 05:08:37
4 @ MyLocation EE) Jsmartaffice/actar_graup_status Dirlevel Zane 5_Cald LED_PANEL Wm0 0 0.0 oK DISABLED Read/Write 22.01.2020 05:08:36
4 [ MyBuilding ] Jsmartoffice/actor_group_status/Bimlevel Zone_9_Cold LED_PANEL W0 00 0.0 ok DISABLED Read/rite 22.01.2020 05:08:36
4 [ Roorn autormation 301 Jsmartoffice/actor group_status/Dimlevel Zone 2 Warm LED_PANEL 2w 0.0 oK DISAELED Read/write 12.01.2020 05:08:36
« B My First Floor 393 Jsmartoffice/actor_ group_status/Dimlevel Zone_1 Warm LED_PANEL 2w 0.0 oK DISAELED Read/Write 22.01.2020 05:08:36
B My First Room 384 Jsmartaffice/actor_group_status/Dimlevel Zone_3 Cold LED_PANEL 3.0 00 00 oK DISABLED Read/MWrite 22.01.2020 05:08:36
# My Second Room E Jsmartoffice/actor_group_status/Bimlevel Zone_§ Warm LED_PANEL 2w 0.0 ok DISABLED Read/rite 22.01.2020 05:08:36
Technics 309 fsmartaffice/actor_group_status/Dimlevel Zone_f_Cold LED_PANEL 3030 00 0.0 oK DISABLED Read/Wirite 12.01.2020 05:08:36
a0 Jsmartoffice/actor_group_status/Dimlevel Zone_4 Gold LED_PANEL W0 00 0.0 oK DISAELED Read/Write 22.01.2020 05:08:36
a1 Jsmartaffice/actar_graup_status Dirlevel Zane_1_Cald LED_PANEL Wm0 0 0.0 oK DISABLED Read/Write 22.01.2020 05:08:36
< i v a0z Jsmartoffice/actor_group_status/Bimlevel Zone_6 Warm LED_PANEL 2w 0.0 ok DISABLED Read/rite 22.01.2020 05:08:36
& evies =gl ® Jsmartoffice/actor group_status/Dirmlevel Zone 3 Warm LED_PANEL 2w 0.0 oK DISAELED Read/write 12.01.2020 05:08:36
g ar Jsmartoffice/actor_ group_status/Dimlevel Zone 9 Warm LED_PANEL 2w 0.0 oK DISAELED Read/Write 22.01.2020 05:08:36
Search., 41 fsmartaffice/actor_group_status/Dimlevel Zone_71_Warm LED_PAMEL 420 0.0 0.0 oK DISABLED Read/Write 22.01.2020 05:08:36.
Tvme . Al| = Jsmartoffice/actor_group_status/Dimlevel Zone_4 Warm LED_PANEL 20w 00 oK DISABLED ReaclfHirte 22012020 05:08:36
ICROSENS 66 Switch 127 it} Jsmartoffice/actor group_status/Dimlevel Zone 10 Cold LED_PANEL W0 00 0.0 oK DISAELED Read/write 12.01.2020 05:08:36
TOROSENS 66 Switch 415 Jsmartoffice/actor_group_status/Dimlevel Zone Al LED_PANEL o0 0.0 oK DISAELED Read/Write 22.01.2020 05:08:37
LCROSENS 66 Micro.Switch =2 Jsmartoffice/sensor/SLD, Dirmevel_Zone_3/1 SUDER B0 0 0.0 ok DISABLED Read only 22.01.2020 05:08:36
LCROSENS 66 Micro-Switeh o Jsmartoffice/sensor/SLD Dirmlevel Zore /1 SUDER B0 0 0.0 ok DISABLED Read only 22.01.2020 05:08:36
ICROSENS 66 Industial S 25 Jsmartoffice/sensor/SLD Dirmlevel Zone 10/1 SUDER: w0 0.0 oK DISAELED Read only 12012020 05:08:36
JOROSENS 66 Industrial S ar fsmartoffice/sensor/SLD_Dirlevel Zone_5/1 SUDER: w0 0.0 oK DISAELED Read only 22.01.2020 05:08:36
JCROSENS 66 Industin] S 62 Jsmartoffice/sensor/SLD, Dirmevel_Zone_6/1 SUDER B0 0 0.0 ok DISABLED Read only 22.01.2020 05:08:36
JCROSENS 66 Industral S 166 Jsmartoffice/sensor/SLD Dirmlevel Zore_1/1 SUDER B0 0 0.0 ok DISABLED Read only 22.01.2020 05:08:36
ICROSENS Central Srart L 2|l oo Jsmartoffice/sensor/SLD Dirnlevel Zone 2/1 SUDER: w0 0.0 oK DISAELED Read only 12012020 05:08:36
[CROSENS Central Smart Lightng { 4 fsmartoffice/sensor/SLD_Dirlevel Zone_3/1 SUDER: w0 0.0 oK DISAELED Read only 22.01.2020 05:08:36
s24 Jsmartoffice/sensor/SLD, Dirmevel_Zone_3/1 SUDER B0 0 0.0 ok DISABLED Read only 22.01.2020 05:08:36
530 Jsmartoffice/sensor/SLD Dirmlevel Zore_4/1 SUDER: B0 0 0.0 ok DISABLED Read only 22012020 05:08:36

Figure 31: SBM Client - Building Administration - Data Points

To mark specific data points for history data double-click the respective checkbox in the
column Save history.

Click on the “open lock” icon on the upper left to submit the changes to SBM Server. The
lock icon changes to a “closed lock” symbol.

To close SBM Client change to the menu entry File and click on the menu item Exit.

15 Start WEB U1

15.1 Prerequisites

After starting SBM Server and enabling the required HTTP service a web browser can be
used to access the server with one of the following URL addresses.

e for standard HTTP connections:
http://<server ip address>:<http server port>/sbm

e for secured HTTP connections, if the secured HTTP was configured on SBM Server:
https://<server ip address>:<https server port>/sbm

Note:
You will find the URL also on the bottom of the SBM Server window:

Senver available at: http://127.0.0.1:8080

Figure 32: SBM Server - Web Server IP Address
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15.2 Login as Valid User

The very first step is to log in to use the UIL. Therefore you will get a login screen before
accessing the WEB UI of the SBM product.

Password

csecese

SIGN IN

Figure 33: SBM WEB UI - Login Screen
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16 Review Building Summary

After login you see the main navigation bar on the left hand side of the WEB UI. If it is not
already active click on the menu item “Building Status”.

(i

Biuilding status

Figure 34: SBM WEB UI - Building Status Icon

Right of the main navigation bar there is a navigation column to navigate through your
building structure for the room automation. In addition on the right hand pane there is a
summary page which shows the most relevant data points as defined for a room. A click on
the “Info button” near the top right corner will open a legend containing information about
the different icons and colour codes used in the summary screen.

“ Summary
™ @ DE-Hamm General OT@r:hmr:a\ Q
Groundfioor

shriroot

@®:0

ﬁ?ﬂ Building status

q“ Technic
Figure 35: SBM WEB UI - Building Structure Navigation and Summary Screen
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17 Review Inventory

Select the node “Inventory” in the main navigation bar on the left hand pane to get an
overview about the managed devices.

“ Inventory

sbmroot

fily Buiding status

Figure 36: SBM WEB UI - Inventory Screen

This page shows all devices, sensors and actors which are installed. When navigating
through the buidling structure nodes the inventory page updates to the components
available for this specific node.
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18 Review History Charts

Click on the node “Charts” in the main navigation bar.

v & DE-Hamm
MICROSENS

shrmroot ~ [ Room automation

EFBIH Building status

Q” Technic

B Schedules

v 1 WyBuilding
» [® Room automation

W Technics

Figure 37: SBM WEB UI - Charts Screen

The charts screen shows the history data charts for the data points which are defined by
SBM client depending on the node which is selected under the Node "Room Automation”.

19 Logout from SBM WEB Ul

Click on the user icon on the top right corner once. A scroll down
menu appears. Click again on the menu item Sign out to logout from
the SBM WEB UL.

Figure 38: SBM WEB UI -
Sign Out
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Disclaimer
All information in this document is provided ‘as is’ and subject to change without notice.

MICROSENS GmbH & Co. KG disclaims any liability for the correctness, completeness or
quality of the information provided, fitness for a particular purpose or consecutive damage.

Any product names mentioned herein may be trademarks and/or registered trademarks of
their respective companies.
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All rights reserved. This document in whole or in part may not be duplicated, reproduced,
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